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Product and Company Information 

The information in this document is confidential proprietary information belonging solely to Constellation 

HomeBuilder Systems, Inc., a wholly owned subsidiary of Constellation Software, Inc. This document is 

supplied under a license and may not be reproduced, published, or disclosed without prior written 

authorization. Constellation licenses its program products (software) to the customer in accordance with 

the terms and conditions of the BuildTopia Software License Agreement. No title or ownership of the 

BuildTopia software is transferred. Any use of the software beyond the terms of the aforesaid license, 

without the prior written authorization of Constellation, is prohibited.  

 

 

The names of companies, products, people, characters and/or data mentioned in screens, reports, and 

other data examples are fictitious and are in no way intended to represent any real individual, company, 

product or event, unless otherwise noted. Any rights not expressly granted herein are reserved.  

 

 

Trademark and Patent Information  

Other product and company names mentioned herein might be the trademarks of their respective owners.  

 

 

Disclaimer of Warranties and Limitation of Liabilities  

The staff at Constellation has taken due care in preparing this information; however, nothing contained 

herein modifies or alters in any way the standard terms and conditions of the BuildTopia License 

Agreement by which the product was acquired. Nor does it increase in any way Constellation’s liability to 

the customer. In no event shall Constellation or its affiliates be liable for incidental or consequential 

damages in connection with or arising from the use of the product, the accompanying documentation, or 

any related materials.   
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Contacting Support and Services  

Support for the BuildTopia software is available at Constellation’s Baltimore and Markham offices.  

 

 

Baltimore Main Office  
Telephone:  1 410 843-3800 

Fax:   1 410 843-3853  

Web:  http://www.constellationhb.com  

 

 

Support Desk  
Support Desk assists with software operations.  

 

Telephone: 1 800 411-2020 Option #4 

Email:  support@buildtopia.com  

Hours: Monday through Friday 9:00 a.m. to 5:00 p.m. (Eastern Standard Time) 

 

Professional Services  

Contact your company’s Professional Services Consultant for assistance with software implementation, 

training, consulting, and data building. 

  

Telephone: 1 905 475-2209 or toll-free at 1 888 723-2222  

Fax:  1 905 475-7204  

Web:  http://www.constellationhb.com 
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Enhancements 

This section highlights new features and enhancements that have been added to BuildTopia. Each item is 

identified by a ticket and / or defect number (where applicable) which tracks to our internal support and 

software development system. The product versions affected are listed with each item. There is also a 
description of the item with any relevant screenshots to detail the enhancement. 

 

Updated Homebuyer Homepage theme 

Defect #:  001-00-1-16867, 001-00-1-17525 

Ticket #:   

Product:    BTBuilder                                    BTSales                                           BTService 

Description:   This release introduces a modern, updated theme for the Homebuyer Homepage that is 

optimized for both desktop and mobile browsers.  

The background image can be changed within the application by going to Admin > 
BTService Setup > Homebuyer Homepage. The 3 choices are: 

• Default image – shown below 

• Custom image – ‘.jpg’ or ‘.gif’ format, and we recommend 1600x1063 or larger  
• A solid color – a color picker is shown, or a hex color code value can be typed in. 

*For best results, we recommend having a company logo with a transparent background 

that will be displayed at the top of the page. If you would like to update the logo currently 
shown on your homebuyer homepages please email a new log to our support team. 

Screenshots:   

Homebuyer Homepage with default background 

 



 

© 2014 Constellation HomeBuilder System, Inc.  All rights reserved.   6 

Admin > BTService Setup > Homebuyer Homepage 

 

  

Ability to schedule automated emails of on-demand reports (permission controlled feature) 

Defect #:  001-00-1-15875 

Ticket #:  001-00-207025 

Product:    BTBuilder                                    BTSales                                           BTService 

Description:   Admin > Company Setup > Reporting Roles > View/Edit 

Reports > On-Demand Reports > Run a report > More Actions > Scheduled Email Delivery 

This feature gives the ability to receive emails of on-demand reports at specified intervals 

to both BuildTopia users within the account and specified email addresses.  

- Only users with the new permission will be able to use this feature. The Reporting 

Admin role gets access to the feature by default. 

- Only the owner of the report will be able to set and edit the schedule. Other users will 
get a view only page showing the schedule details. 

Screenshots:   

Admin > Company Setup > Reporting Roles > View/Edit 

 

 

Reports > On-Demand Reports > Run a report > More Actions > Scheduled Email Delivery 
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Ability to change the owner of on-demand reports (permission controlled feature) 

Defect #:  001-00-1-17654 

Ticket #:   

Product:    BTBuilder                                    BTSales                                           BTService 

Description:   Reports > On-Demand Reports > Run a report 

This feature gives the change the owner of on-demand reports.  

- Only users with the new permission will be able to use this feature. The Reporting 

Admin role gets access to the feature by default. 

- Users with this permission will see the name of the current owner of the report next to 

the report name in blue text. If the blue text is clicked a dropdown showing other 

users with access to that module of data sets will be shown. 

- Users without this permissions will see the name of the current owner of the report in 

black text, and will not be able make any changes. 

Screenshots:   

Admin > Company Setup > Reporting Roles > View/Edit 

 

 

Reports > On-Demand Reports > Run a report 
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Ability to generate PDF versions of on-demand reports 

Defect #:  001-00-1-10190 

Ticket #:  001-00-151552 

Product:    BTBuilder                                    BTSales                                           BTService 

Description:   Reports > On-Demand Reports > Run a report > More Actions 

PDF versions of on-demand reports can now be generated. 

Screenshots:   

 

 

Admin 

 

Addition of the option to select email templates on the Webkit Prospect Form 

Defect #:  001-00-1-15715 

Ticket #:   

Product:    BTBuilder                                    BTSales                                           BTService 

Description:   Admin > Projects > Project Settings > Webkit Prospect Form 

Sales email templates can now be selected for the Auto-Response and Notification emails 
in the Webkit setup process. 

 

Updates to the Schedule View pages 

Defect #:  001-00-1-16885, 001-00-1-17015 

Ticket #:  001-00-223541, 001-00-224021 

Product:    BTBuilder                                    BTSales                                           BTService 

Description:   PM > Lot Matrix > Review Schedule 

Data Library > Schedules > View 

We have added alternate coloring for task rows, and yellow highlighting that moves with 
the cursor on these pages to make it easier to view and manage the tasks. 
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Updates to the Manage Message Forwarding page in the ‘My Profile’ section 

Defect #:  001-00-1-15843 

Ticket #:   

Product:    BTBuilder                                    BTSales                                           BTService 

Description:   My Profile > Manage Message Forwarding 

Usability updates were applied to the manage message forwarding page. 

 

Updates to the Queue pages for BTAccounting/Dynamics integration 

Defect #:  001-00-1-17376 

Ticket #:   

Product:    BTBuilder                                    BTSales                                           BTService 

Description:   A new column called 'Parameters' has been added to give more information about the 
data being sent to Dynamics. Also, a filter has been added for the 'Task' column. 

 

Sales  

 

Updates to the Buyers and SPECs lists 

Defect #:  001-00-16567 

Ticket #:  001-00-221075 

Product:    BTBuilder                                    BTSales                                           BTService 

Description:   The following updates have been made to the different tabs on the Buyers and SPEC lists: 

Sales > SPECs 

• Update of the name of the tab from ‘SPEC List’ to ‘SPECs’ 

• Addition of new columns to the list of current SPECs: Accepted Date,  NSOs 
• Addition of a new tab to show information for terminated SPECs. 

Sales > Buyers > Terminated tab 

Sales > SPECs > Terminated tab 

The following updates have been made to the different tabs on the Buyers and Sales lists 
in sales based on feedback: 

• Addition of new columns: Base Price, Premium, Options, NSOs, Termination Date 

• Removal of the ‘Construction Status’ column and the Actions column. 

 

Addition of NSO and documents columns to the workups table on prospects workup page 

Defect #:  001-00-1-17005 

Ticket #:  001-00-224075 

Product:    BTBuilder                                    BTSales                                           BTService 

Description:   Sales > Prospects > Workups 

Columns have been added workup list for prospects to show the total of NSOs currently 
added to the workup, and associated documents. 
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Updates to the Price Plans page 

Defect #:  001-00-1-17125 

Ticket #:  001-00-224435 

Product:    BTBuilder                                    BTSales                                           BTService 

Description:   Sales > Price Plans 

Columns to shown Plan Number and Square Footage were added to this page. 

 

Updates to the Price Options page 

Defect #:  001-00-1-17514 

Ticket #:   

Product:    BTBuilder                                    BTSales                                           BTService 

Description:   Sales > Price Options 

Columns to shown Plan Number and Square Footage were added to this page. 

 

A 'Save and Add Another' button has been added to the survey page after adding a prospect 

Defect #:  001-00-17124 

Ticket #:  001-00-223413 

Product:    BTBuilder                                    BTSales                                           BTService 

Description:   Sales > Prospects > Add Prospect > Save & Continue > Survey 

When manually adding a prospect, if 'Save & Continue' is clicked the survey is shown. We 

have now added a 'Save and Add Another' button to the survey page in this instance that 
will make it easier to enter multiple prospects with their survey information. 

 

Project Management 

 

Update to the ‘Apply CO to Activity List’ process to ensure that change orders are updated in order 

Defect #:  001-00-1-16138 

Ticket #:   

Product:    BTBuilder                                    BTSales                                           BTService 

Description:   PM > Lot Matrix > CO  

The ‘Apply CO to Activity List’ process has been updated to ensure that change orders are 

updated in chronological order, so long as they approved. 
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Reports 

 

Addition of a Tasks Purchase Orders section to the Schedule Tasks data set 

Defect #:  001-00-1-12193 

Ticket #:   

Product:    BTBuilder                                    BTSales                                           BTService 

Description:   Reports > On Demand Reports > New Reports > Scheduling > Scheduling Tasks  

A new section, 'Task Purchase Orders' has been added to this data set with the following 

fields: Activity Code Name, Activity Code No + Name, Activity Code Number, Activity 

Package Name, Activity Package No + Name, Activity Package Number, NSO Number, 

Option Code Name, Option Code No + Name, Option Code Number, PO Number, PO 
Status, Trade Name, Trade No + Name, Trade Number, Trade Partner. 

Addition of activity package information to the NSO on-demand data set 

Defect #:  001-00-1-15918 

Ticket #:  001-00-223714 

Product:    BTBuilder                                    BTSales                                           BTService 

Description:   Reports > On-Demand > New Report >Purchasing > NSOs > NSO Estimate Information 

section  

These fields have been added: Activity Package No, Activity Package Name, Activity 

Package No + Name. 

Addition of a NSO Quotes Information section to the purchasing NSOs data set 

Defect #:  001-00-1-15915 

Ticket #:   

Product:    BTBuilder                                    BTSales                                           BTService 

Description:   Reports > On-Demand > New Report >Purchasing > NSOs  

A new section, 'Task Purchase Orders' has been added to this data set with the following 

fields: Trade Partner Name, Trade Partner Quote Status, Expiration Date, , Activity Code 

No, Activity Code Name, Activity Code No + Name, Activity Package No, Activity Package 

Name, Activity Package No + Name, Scope of Work, Unit Cost, Quantity, Amount, Tax 

Rate, Tax Amount, Total Amount. 

Addition of the Variance % field to Activity List w/Schedule Information data set 

Defect #:  001-00-1-17144 

Ticket #:  001-00-223714 

Product:    BTBuilder                                    BTSales                                           BTService 

Description:   Reports > On-Demand Reports > New Reports > Scheduling> Activity List w/Schedule 

Information  

A new field has been added to this data set in the 'Activity List Information' section - 
Variance %. It shows the value of (Projected Variance/Current Budget) x 100. 
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Customer Service 

 

Addition of ‘Edit’ and Delete’ features for Co-Owners in service 

Defect #:  001-00-1-15764 

Ticket #:  001-00-221497, 001-00-221699, 001-00-224960 

Product:    BTBuilder                                    BTSales                                           BTService 

Description:   CS > Owners > Owner Name > Co-Owner Name 

‘Edit’ and ‘Delete’ links have been added on the co-owner detail page. 

 

Usability updates the 'Associated People' tab on the owner page 

Defect #:  001-00-1-17506 

Ticket #:   

Product:    BTBuilder                                    BTSales                                           BTService 

Description:   CS > Owners > Owner Name > Associate Person & Associated People tab 

Usability updates have been made to these pages. 

 

General 

 

Updates to the messages displayed when trying to log in with incorrect login information 

Defect #:  001-00-1-17344, 001-00-1-17374, 001-00-1-17375 

Ticket #:   

Product:    BTBuilder                                    BTSales                                           BTService 

Description:   We have updated the messages displayed when the email address of password provided 

for login are incorrect in an effort to make it easier to recover login information.  

 

Updates to the calendar selection tools 

Defect #:  001-00-1-16935, 001-00-1-17139 

Ticket #:  001-00-224178 

Product:    BTBuilder                                    BTSales                                           BTService 

Description:   The calendar selection tools have been updated across the application. 

 

Replacement of ‘Select All’ & ‘Clear All’ buttons with multi-select checkboxes 

Defect #:  001-00-1-14847 

Ticket #:   

Product:    BTBuilder                                    BTSales                                           BTService 

Description:   Select All' and 'Clear All' buttons have been updated with multi-select checkboxes.' 
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Defect Fixes 

This section highlights corrections and defect fixes that have been applied to BuildTopia. Each item is 

identified by a ticket and / or defect number (where applicable) which tracks to our internal support and 

software development system. The product versions affected are listed with each item. There is also a 
description of the item with any relevant screenshots to detail the defect. 

 

Admin 

 

Issue with the display percentages of draw activity packages on options on project plans 

Defect #:  001-00-1-16193 

Ticket #:   

Product:    BTBuilder                                    BTSales                                           BTService 

Description:   Admin > Projects > Plans > Options > View 

Admin > Projects > Plans > Options > Edit Status Only 

Percentages were not displayed for activity packages on option on these pages. This has 
been corrected. 

 

Issue with the drop downs on the generated WIK form 

Defect #:  001-00-1-17297 

Ticket #:   

Product:    BTBuilder                                    BTSales                                           BTService 

Description:   Admin > Projects > Project Settings > Webkit Prospect Form > Questions 

When ‘drop down’ survey questions were included on the WIK form, the generated form 

did not allow a blank value, which forced the user to have to pick a selection, which was 
not correct when the question was not required. This has been corrected. 

 

Updates to the preview survey page 

Defect #:  001-00-1-16469 

Ticket #:  001-00-219454 

Product:    BTBuilder                                    BTSales                                           BTService 

Description:   Admin > Project > View > Edit Survey > Preview Survey 

The preview survey page has been updated to include both company and project survey 
questions. 

 

Update of default status filter value on the schedule template list in the Data Library 

Defect #:  001-00-1-17105 

Ticket #:  001-00-220843 

Product:    BTBuilder                                    BTSales                                           BTService 

Description:   Data Library > Schedules 

The default value for the status schedule templates list will now be 'Active.' 



 

© 2014 Constellation HomeBuilder System, Inc.  All rights reserved.   14 

Issue with lot custom fields 'Number 3', 'Number 4' & 'Number 5' 

Defect #:  001-00-1-17136 

Ticket #:  001-00-224474 

Product:    BTBuilder                                    BTSales                                           BTService 

Description:   Admin > Projects > Lots > Edit 

When a value was saved on the 'Number 3' lot custom field the same value was saved on 
the 'Number 4' and Number 5' fields. This issue has been corrected. 

 

Issue with the lot premium field 

Defect #:  001-00-1-17044, 001-00-1-16289 

Ticket #:  001-00-224253, 001-00-225218 

Product:    BTBuilder                                    BTSales                                           BTService 

Description:   Admin > Projects > Lots > Edit 

Sales > Lot Matrix > Edit  

PM > Lot Matrix > Edit 

The lot premium field incorrectly gave an error message in some cases. This has been 
corrected. 

 

Update to the ‘Project Type’ field for critical dates functionality 

Defect #:  001-00-1-17351 

Ticket #:  001-00-225799 

Product:    BTBuilder                                    BTSales                                           BTService 

Description:   Admin > Projects > Edit  

The 'Project Type' field for critical dates that is only shown when a project is in the 
'Ontario' project is now a required field to enable the critical dates functionality. 

 

Issue with the permissions that control access to projects for accounting exports 

Defect #:  001-00-1-16973 

Ticket #:  001-00-223375 

Product:    BTBuilder                                    BTSales                                           BTService 

Description:   Admin > Company Setup > Administrator Roles > View/Edit > 'Access Exports for all 

Projects' 

Some users could see all projects on the new export/re-export pages when they did not 
have this permission. This has been corrected. 
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Updates to the Messages section 

Defect #:  001-00-1-16925, 001-00-1-16972 

Ticket #:  001-00-223079 

Product:    BTBuilder                                    BTSales                                           BTService 

Description:   Home > Messages 

While searching for messages, the date sort was reset if the project filter was used. This 
has been corrected. The page layout has also been updated. 

 

Sales 

 

Issue with the ‘Prospects View Only’ sales permission 

Defect #:  001-00-1-16975 

Ticket #:  001-00-223706 

Product:    BTBuilder                                    BTSales                                           BTService 

Description:   Admin > Company Setup > Sales Permissions > View/Edit > View Only permission under 

the Prospects section 

Users with this permission could see the To-Do tab. Also, on the prospects tab they could 

not view any workup details. This has been corrected to ensure that their access to the 

To-Do tab is controlled by those specific permissions, and that they have access to view 

prospect workups but not make any changes. 

 

Issue with the options tab on the workup page for workups with lots in another project 

Defect #:  001-00-1-17664 

Ticket #:  001-00-227064 

Product:    BTBuilder                                    BTSales                                           BTService 

Description:   Sales > Prospects > Workups > Manage Workup 

When a workup was created with a lot in a different project, the options were not shown 

on the manage workup page if the plan on the workup was not associated to the project 
for the prospect. This has been corrected. 

 

Issues with the contacts list shown on the Homebuyer Homepage (HBHP) 

Defect #:  001-00-1-17224 

Ticket #:  001-00-224991 

Product:    BTBuilder                                    BTSales                                           BTService 

Description:   Homebuyer Homepage Contacts page 

When a company contact that was not a BuildTopia user was added to the contact list in 

the HBHP setup section in Admin > Projects, that contact was not shown on the HBHP. 
This has been corrected. 
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Issue with the plan filter on the buyer's list 

Defect #:  001-00-1-17007 

Ticket #:  001-00-224115 

Product:    BTBuilder                                    BTSales                                           BTService 

Description:   Sales > Buyers 

In some cases the Plan filter on the buyer's list does not return results even when there 
are matching values. This has been corrected. 

 

Issue when viewing broker agent details from Sales 

Defect #:  001-00-1-17024 

Ticket #:  001-00-224083, 001-00-224142 

Product:    BTBuilder                                    BTSales                                           BTService 

Description:   Sales > Broker Agents/Mortgage Cos > Broker Agents tab > Broker Name 

The broker details shown when the broker name was clicked were inconsistent. This has 

been corrected. 

 

Issue with the attachment box for prospect emails 

Defect #:  001-00-1-17662 

Ticket #:   

Product:    BTBuilder                                    BTSales                                           BTService 

Description:   Sales > Prospects > Emails > Attachment  

• The pop-up box for selection of documents was formatted incorrectly, and the dates 

were shown in an incorrect format. These issues has been corrected.  
• We have also added a filter for the ‘Author’ column. 

 

Issue with the @@incentives@@ contract template tag 

Defect #:  001-00-1-17475 

Ticket #:  001-00-226154 

Product:    BTBuilder                                    BTSales                                           BTService 

Description:   Sales > Manage Buyers & SPECS > Agreement > View/Print Contract 

When the @@incentives@@ tag was used on generated sales contracts unusual 

characters were shown, or an error message was shown. This has been corrected.  

 

Addition of plan information to the CO with History print form 

Defect #:  001-00-1-17294 

Ticket #:  001-00-223938 

Product:    BTBuilder                                    BTSales                                           BTService 

Description:   Sales > Buyers > CO > CO with History 

Plan information has been added to the CO with History print form. 
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Issues with the printable version of the financials calculations 

Defect #:  001-00-1-16968 

Ticket #:  001-00-223848 

Product:    BTBuilder                                    BTSales                                           BTService 

Description:   Sales > Prospects/Buyers > Financials > Printer icon  

When this print form was generated two pages were produced when all the data could fit 
on one page. This has been corrected. 

 

Issue with the Pricing addendum with taxes print form in Canadian accounts 

Defect #:  001-00-1-17025 

Ticket #:  001-00-224047, 001-00-224173, 001-00-224975 

Product:    BTBuilder                                    BTSales                                           BTService 

Description:   Sales > Prospects > Workups > Manage Workups > View/Print Pricing 

Addendum/Agreement Price Log > Pricing Addendum with Taxes 

The Pricing addendum with Taxes print form was not showing tax information when 
generated immediately after creating a new workup. This has been corrected. 

 

Bidding & Contracting 

 

Issue when copying pricing for turnkey bids/contracts 

Defect #:  001-00-1-16446, 001-00-1-17358 

Ticket #:  001-00-00-221493, 001-00-222813 

Product:    BTBuilder                                    BTSales                                           BTService 

Description:   BC > Bids > Turnkey > View > Copy Pricing 

BC > Contracts > Turnkey > View > Copy Pricing 

In some cases the tax was not calculated correctly when using this feature. This has been 

corrected to ensure that the tax is calculated correctly according to the tax percentage of 

the project that is receiving the prices. Instructional text has also been added to the page 

to help avoid confusion. 

 

Issue with documents when creating a revised contract 

Defect #:  001-00-1-16686 

Ticket #:  001-00-2 

Product:    BTBuilder                                    BTSales                                           BTService 

Description:   BC > Contracts > View > Create Revision 

Documents that were associated to the original contract were not carried over to the 
contract revision. This has been corrected. 
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Issue with the update of the proforma budget for some option activity package activities 

Defect #:  001-00-1-16994 

Ticket #:  001-00-222979 

Product:    BTBuilder                                    BTSales                                           BTService 

Description:   BC > Proforma Budgets > Option 

In some cases the proforma budget was not updated on activities on draw activity 
packages on options. This issue has been corrected. 

 

Update to the display of draw package activities on the proforma budgets page 

Defect #:  001-00-1-16805 

Ticket #:  001-00-221558 

Product:    BTBuilder                                    BTSales                                           BTService 

Description:   BC > Proforma Budgets > Base 

When looking at the activities of a draw package on a plan on the proforma budgets page 

in BC, only one activity is shown because the application divides the entered amount 

according to the defined percentages. We have added an information icon for these 

activities. Hovering a cursor over the information icon will display an explanation of this 
feature.  

 

Issue with external emails with creating a turnkey bid 

Defect #:  001-00-1-17484 

Ticket #:  001-00-226052 

Product:    BTBuilder                                    BTSales                                           BTService 

Description:   BC > Bids > Turnkey > Create 

When creating a turnkey bid, there is a field called 'External Email(s)' for email addresses 

for Trade Partners who do not have BuildTopia Trade Partner accounts. In some cases 
these external email addresses where not receiving emails. This has been corrected. 

 

Update to the Unit of measure bid history to sort by activity code 

Defect #:  001-00-1-16694 

Ticket #:  001-00-222703 

Product:    BTBuilder                                    BTSales                                           BTService 

Description:   BC > Bids > Unit of Measure > View > History 

When viewing the history of a unit of measure bid, the activities were not sorted 
alphabetically which made it difficult to find specific activities. This has been corrected. 
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Project Management 

 

Issue with the update of current budgets of NSOs when using the update wizard 

Defect #:  001-00-1-16854 

Ticket #:  001-00-220038 

Product:    BTBuilder                                    BTSales                                           BTService 

Description:   PM > Lot Matrix > Update Wizard > Update Current Budget 

When the update wizard was used to update the current budgets of NSO activities that 

had a quantity less than 1, the current budget for those NSO activities was not updated 

correctly. This has been corrected. 

 

Issue with the handling of related schedule tasks when a purchase order was voided 

Defect #:  001-00-1-16237 

Ticket #:  001-00-220254 

Product:    BTBuilder                                    BTSales                                           BTService 

Description:   When a purchase order is voided, the application will now check whether it has a related 

schedule task. If one exists the association will be broken to free the task to be associated 
to a new purchase order. 

 

Issue with the variance code for purchase orders on the purchase order edit page 

Defect #:  001-00-1-16175, 001-00-1-17234 

Ticket #:  001-00-220049 

Product:    BTBuilder                                    BTSales                                           BTService 

Description:   PM > Purchase Orders > Edit 

• Updates were made to this page to ensure that a change that affects the total amount 

of the Purchase Order has to exist before the variance code can be updated. 

**Variance codes can still be managed directly from the Variance Log (PM > Variance 

Log). 

• When editing an existing manual purchase order, the variance code drop down showed 

no value even though there was a variance code currently saved. This has been 
corrected. 

 

Confirmation box added when deleting schedule tasks 

Defect #:  001-00-1-16464 

Ticket #:  001-00-217027 

Product:    BTBuilder                                    BTSales                                           BTService 

Description:   Data Library > Schedules > Schedule Template Name > Delete  

PM > Lot Matrix > Review Schedule > Delete  

A confirmation box will be shown when deleting a schedule template task or schedule 
task. 
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Update of the ‘Add an Activity’ link to ‘Add Activities/Activity Packages’ 

Defect #:  001-00-1-17659 

Ticket #:   

Product:    BTBuilder                                    BTSales                                           BTService 

Description:   PM > Lot Matrix > Activity List 

The 'Add an Activity' link has been changed to ‘Add Activities/Activity Packages’. 

 

NSOs 

 

Issues with selection on the NSO estimate add activities & add activity packages pages 

Defect #:  001-00-1-17445 

Ticket #:  001-00-226047 

Product:    BTBuilder                                    BTSales                                           BTService 

Description:   NSO > Estimates > Add Activities 

NSO > Estimates > Add Activity Packages 

When adding activities or activity packages to a NSO, if the page counter was used any 
selections made were lost. This has been corrected. 

 

Issues on the NSO estimate edit page 

Defect #:  001-00-1-17435 

Ticket #:  001-00-226047 

Product:    BTBuilder                                    BTSales                                           BTService 

Description:   NSO > Estimates > Edit 

• A ‘Save’ button has been added to allow changes to be saved without being redirected 

to the estimate view page. 
• If the user tries to leave the page without saving changes a prompt will be shown. 

 

Customer Service 

 

Error message when sorting Service Order notes by the’ Create Date’, ‘Created By’, & ‘Visible to TP’ columns 

Defect #:  001-00-1-16989 

Ticket #:  001-00-223948 

Product:    BTBuilder                                    BTSales                                           BTService 

Description:   CS > Service Orders > Service Order number > Notes Tab 

An error message was shown when sorting service order notes by the ‘Create Date’, 
‘Created By’, & ‘Visible to TP’ columns. This issue has been corrected. 
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‘Edit’ link for CS request items has been moved from the button to the actions list 

Defect #:  001-00-1-17625 

Ticket #:   

Product:    BTBuilder                                    BTSales                                           BTService 

Description:   CS > Requests > Request Number > Items > Item Number  

The ‘Edit’ link for CS request items has been moved from the button to the actions list. 

 

Issue when adding new owners on new lots in BTService only accounts 

Defect #:  001-00-1-17535 

Ticket #:  001-00-226444, 001-00-227137, 001-00-227333 

Product:    BTBuilder                                    BTSales                                           BTService 

Description:   CS > Owners > Add an Owner > Next 

In some cases when a new owner is added in a BTService Only account using the 'Add an 
Owner' link the lot number was not created correctly. This has been corrected. 

 

Reports 

 

Updates to the Request with Items data set to improve performance 

Defect #:  001-00-1-15974 

Ticket #:   

Product:    BTBuilder                                    BTSales                                           BTService 

Description:   Reports > On-Demand Reports > New Reports > Customer Service > Request with Items 

Updates have been made to this data set to improve the speed at which it returns data. 

 

Issue with the 'Approve User' column on the purchasing data sets 

Defect #:  001-00-1-16077 

Ticket #:  001-00-220859 

Product:    BTBuilder                                    BTSales                                           BTService 

Description:   Reports > On-Demand Reports > New Report > Purchasing > Purchase Order Header > 

Purchase Order Header section 

‘BuildTopia on Demand’ was displayed for POs that had not been approved. Going forward 

the value will be blank for POs that have not been approved. 
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Adjustment to sorting of on-demand reports by name 

Defect #:  001-00-1-17106 

Ticket #:   

Product:    BTBuilder                                    BTSales                                           BTService 

Description:   Reports > On-Demand Reports 

On-demand reports will now be sorted alphabetically at 2 levels, first report name, then 
by report description. 

 

General 

 

Correction of search fields on various pages 

Defect #:  001-00-1-17196, 001-00-1-17359, 001-00-1-17645, 001-00-1-17646, 001-00-1-17647 

Ticket #:  001-00-224851, 001-00-225537, 001-00-226959 

Product:    BTBuilder                                    BTSales                                           BTService 

Description:   Data Library > Plans > Projects 

Data Library > Plans > Projects > Lots 

Data Library > Plans > Projects > Lots > Associate Lots  

Data Library > Options > Copy Option Code 

Data Library > Activities > Edit > Save and Flowdown > Next > Next > Next (Plan Option 

Activities) 

Issues with the search fields on the pages above have been corrected. 

 

Issue with module navigator on some pages 

Defect #:  001-00-1-17195, 001-00-1-16934, 001-00-1-17225, 001-00-1-17788  

Ticket #:  001-00-223779, 001-00-224910, 001-00-225179, 001-00-226768, 001-00-227560 

Product:    BTBuilder                                    BTSales                                           BTService 

Description:   The module navigator has been updated to address various issues on the following pages: 

Sales > Prospects > Workups > Select Option 

Sales > Price Options 

PM > Lot Matrix, and related pages 

PM > Lot Matrix > Edit 

PM > Lot Matrix > CO 

PM > Lot Matrix > Options 

PM > Lot Matrix > Purchase Orders > Generate Purchase Orders 

Sales > Manage Buyers & SPECs 

Sales > Broker Agent/Mortgage Cos > View 

Sales > Broker Agent/Mortgage Cos > View > Edit 

Sales > Broker Agent/Mortgage Cos > Mortgage Companies, and related pages 

Sales > Broker Agent/Mortgage Cos > Broker Agents and related pages   
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Trade Partner Accounts 

 

Activities marked as 'Do not Bid' on unit of measure bids are now hidden in TP accounts 

Defect #:  001-00-1-17064 

Ticket #:   

Product:    BTBuilder                                    BTSales                                           BTService 

Description:   Trade Partner account > Bids > Unit of Measure > Edit 

Activities marked as 'Do not Bid' on Unit of Measure bids in the builder's account could be 

seen, but not updated on the Trade Partner‘s side which caused confusion. They will now 

be hidden.  

 

Project Company Name has been added to the purchase order view page in TP accounts 

Defect #:  001-00-1-17104 

Ticket #:  001-00-219729 

Product:    BTBuilder                                    BTSales                                           BTService 

Description:   TP Account > Purchase Orders > Select a company > Click on a PO #  

Currently only the project name is shown on the purchase order view page, which may 

cause confusion when it is different from the project company name. The page has been 
update to show both the project name and the project company name. 

 

Old message forwarding setting showing on the 'Add Users' page in TP accounts 

Defect #:  001-00-1-17140 

Ticket #:   

Product:    BTBuilder                                    BTSales                                           BTService 

Description:   Trade Partner Account > Admin > Users > Add Users 

The old global message forwarding setting was still showing on the 'Add Users' page in TP 
accounts. This has been corrected. 

 

Browser related 

 

Issue with sending individual emails to prospects when using Internet Explorer with compatibility mode ‘On’ 

Defect #:  001-00-1-16524, 001-00-17000 

Ticket #:  001-00-222059 

Product:    BTBuilder                                    BTSales                                           BTService 

Description:   Sales > Prospects  > Email 

When using Internet Explorer with compatibility mode ‘On’ the individual prospect email 

generated on by this page could not be sent. This has been corrected. 
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Issue with the display of Campaign names when using Internet Explorer with compatibility mode ‘On’ 

Defect #:  001-00-1-15897 

Ticket #:   

Product:    BTBuilder                                    BTSales                                           BTService 

Description:   Admin > Company Setup > Prospect Type Code > Project & Campaign Associations 

Campaign names were not shown correctly on this page when using Internet Explorer with 
compatibility mode ‘On.’ This has been corrected. 

 

Issue when using the browser back button from PM Lot Matrix > Lot View 

Defect #:  001-00-1-16826 

Ticket #:  001-00-223181 

Product:    BTBuilder                                    BTSales                                           BTService 

Description:   PM > Lot Matrix > View  

• The lot view page would not show lot information consistently when the ‘Back’ button 

was used. This has been corrected. 

• Use of the ‘Back’ browser button gave inconsistent results throughout the NSO 

module. This has been corrected. However, we do not recommend using the ‘Back’ 

browser button when working in BuildTopia. 

 

Issues on the ‘Buyer Acceptance’ tab of the NSO list, and use of the ‘Back’ browser button 

Defect #:  001-00-1-17565, 001-00-1-16275 

Ticket #:  001-00-220949, 001-00-221134 

Product:    BTBuilder                                    BTSales                                           BTService 

Description:   NSO > NSO List > Buyer Acceptance 

• The Buyer Acceptance tab would not consistently load correct results. This has been 

corrected. 

• Use of the ‘Back’ browser button gave inconsistent results throughout the NSO 

module. This has been corrected. However, we do not recommend using the ‘Back’ 

browser button when working in BuildTopia. 

 

Issue when entering phone numbers for prospects when using an tablet browser 

Defect #:  001-00-1-17208 

Ticket #:  001-00-224976 

Product:    BTBuilder                                    BTSales                                           BTService 

Description:   Sales > Prospects > Add Prospect 

Sales > Prospects > Edit 

Sales > Prospects > Prospect Name > Actions > Add Co-Prospect 

Sales > Prospects > Prospect Name > Co-Prospects tab > Edit 

We have made adjustments to the phone number fields to make it easier to enter phone 
numbers for prospects and co-prospects when adding/editing prospects and co-prospects. 
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BuildTopia Product Roadmap 

These are some of the new features and enhancements scheduled for future releases in 2014. This 

information is not a complete list of all features that will be in the releases, and is subject to change. If 

you have any suggestions in these areas, please contact the Customer Support Desk.  

  

Version 6.6.3, Q1 2015 

 

• Completion of updates to sales. 

• Updates to detailed permissions for sales. 

• Updates to the Update Wizard in project management. 

• Updates to bid/contract comparison tools in bidding & contracting. 


